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1.

1.3 

 - WEEE

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government of�ce, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please �nd out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers
Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation in national take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors, 
which recycle all materials (products and related 
packaging material) in accordance with all 
Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit 

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2.

2. 

2.1 

 
220S4LS/220S4LA

 

220S4L

220S4LC

 

220S4LC

 
220S4LS/220S4LA

1.   

2. 
(1)  

(2)  

1

2
VGA DVIAudio

Audio VGA DVI



5

2.

220S4LC

1.   

2. VESA

3. 
(1)  

(2)  

2
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2.

  PC
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2.

2.2 

 

220S4LS/220S4LC
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2.

 (OSD)

(OSD)?
On-Screen Display OSD

Philips LCD  
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OSD
 OK

)

OSD
OSD  

Main menu Sub menu

Picture

OSD Settings

Setup

Language

Color

Input

Audio 
(220S4LA)

Picture Format

Brightness

Contrast

Horizontal

Vertical

Transparency

OSD Time Out

Auto

V.Position

Phase

Clock

Resolution Notification

Reset

Information

English, Español, Français, Deutsch, Italiano, 
Português, Русский, 

Color Temperature

sRGB

User Define

VGA

DVI

Stand-Alone

Mute

SmartContrast

Gamma

H.Position

Power LED

Wide Screen, 4:3

0~100

0~100

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

On, Off

Yes, No

0~100

0~100

0~100

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100

Green: 0~100

Blue: 0~100

Off, On

Off, On

Off, On

1.8, 2.0, 2.2, 2.4, 2.6 

0~100

0, 1, 2, 3, 4
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2.

 

1680 
x 1050 @ 60 Hz  

 
Use 1680  1050 @ 60 

Hz for best results 1680 x 1050 @ 60 
Hz

 

20

-5

(220S4LS/220S4LA/220S4LC)

-65
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(220S4LC)

0°

90°

(220S4LC)
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2.

2.3 VESA

220S4LS/220S4LA

1.   

2. 

3. 

4. 

220S4LC

1. 
 

2. 

1
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2.

3. 

1

2

4. 

 
100mm x 100mm  

VESA-

100mm

100mm
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3.

3. 

3.1 SmartImage

 ?
SmartImage 

 

Philips SmartImage 
 

 ? 

SmartImage 

 ? 
SmartImage  Philips 

 
SmartImage 

 - 

  SmartImage

1.    SmartImage
2.    Of�ce ( )  

Photo ( ) Movie ( )  
Game ( ) Economy ( )  
Off ( )

3. SmartImage OSD  5 
 "OK "

4.  SmartImage  
sRGB  sRGB

  
SmartImage

     
OK )

SmartImage OSD

 6  Of�ce
Photo Movie Game

Economy Off
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� Office  
 

PDF 

� Photo  

 – 
� Movie  

� Game  
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3.

� Economy  

� Off   SmartImage 

3.2 SmartContrast

 ? 

 

 ? 

 SmartContrast 

 
 

 ? 
 SmartContrast 

 

3.3 Philips SmartControl Premium
Phillips  SmartControl Premium 

 

/ RGB

 Windows 7 
 

Philips !

 
�  
�  
� 

�  SmartControl Premium 
 

�  
� Plug-in ( )

 
� Standard
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3.

 Standard

Adjust ( )
�  Adjust

 Brightness Contrast
 Resolution  

�  
� Cancel ( )  

Color( )  
� Color

RGB Black Level  
White Point Display Gamma 

 Gamma Calibration
SmartImage SmartKolor  

�  
�  
� Color Calibration ( )
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3.

1. Show Me ( )
 

2. Start ( ) -  6  
3. Quick View ( ) /

 
4.  Color ( ) 

 Cancel ( )  
5. Enable color calibration ( ) - 

 

 
6. 
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3.

 

� Previous 
( )

� Next ( ) 6 

� File > Presets >

� Cancel ( )

SmartImage

Enter tainment ( )
 SmartContrast  SmartResponse

Eco Power (ECO)

Options
Options>Preferences ( > ) - 

Options ( )
Preferences ( )  

 DDC/CI Help 
( ) Option( )

�  
�  

 
� ( ) 

Enable Context Menu (
)  Enable Context Menu (

)  
SmartControl Premium  Select Preset  
( )  Tune Display ( )
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3.

  
SmartControl Premium  

�  ( ) Enable Task 
Tray ( )  Enable 
Context Menu ( )  
SmartControl Premium  

Help 
( ) Technical Support (

) Check for Update
About  Exit  

 Enable Task Tray Menu
 

Exit  
�  ( ) Run 

at Startup ( )  
SmartControl Premium 

  
SmartControl Premium 

 

 
�  (Windows 7/Vista/XP)  

 0% 
Options( )>Audio( ) - 
Options ( ) Audio ( ) 

 DDC/CI
Help ( ) Option ( )

 

Option( )>Auto Pivot( )

Options( )>Input >( ) - 
Options( ) Input ( )

  DDC/
CI Help ( ) Option(

)   SmartControl 
Premium 

�  Source ( )
 

� 
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3.

Options > Theft Deterrence  
- Plug-in
Theft Deterrence
Theft Deterrence

Theft Deterrence ( )
On Theft Deterrence ( )

�  4  9  PIN  
�  PIN  Accept ( )

 
�  5  

 5  
� 

Theft Deterrence ( )
 PIN Theft Deterrence ( )

Theft Deterrence Enabled (
) PIN Options (PIN )

�  Enable Theft Deterrence (
)  

�  Theft Deterrence ( )
 

� PIN Options (PIN )
 PIN  

PIN 

Help
Help ( )> User Manual ( )  - 

User Manual (
)  

 DDC/CI Help ( )
Option( )

Help ( )>Version( ) - Help 
( )  (Version)

  DDC/
CI Help ( ) Option (

)
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Context Sensitive menu ( )
Context Sensitive menu ( )

 Options (
)>Preferences ( )

Enable Context Menu ( )

Context Menu ( )  4 

� SmartControl Premium - 
About ( )  

�� Select Preset ( ) - 

 Factory Preset ( )
 

 
�� Tune Display ( ) -  

SmartControl Premium  
� SmartImage -   

Off ( ) Office ( )  
Photo ( ) Movie ( )  
Game ( )  (Economy)

 SmartControl 
Premium  

 5 

�� Help ( ) -  
 User Manual (

)  
�� Technical Support ( ) - 

 
�� Check for Update ( ) - 

PDI  
�� About ( ) -  

 
� Exit( ) -  SmartControl 

Premium
 SmartControl Premium

Program ( )  SmartControl 
Premium  PC 

Exit ( )  
 SmartControl Premium

Options ( )>Preferences ( )
Run at Startup ( ) 

 
 SmartControl

 
www.portrait.com/

dtune/phl/enu/index SmartControl
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3.4 SmartDesktop 

 SmartDesktop

SmartDesktop  SmartControl Premium 
 SmartControl Premium  

Options ( )  SmartDesktop

�� Align to 
partition ( ) 

��

� Identify ( ) 

 

 Align to 
partition ( )

 

1.  Control Panel ( )  
System ( )

2.  Advanced ( )  
Vista  Win7 

3.  Performance ( )  
Settings ( )

4.  Show window contents 
while dragging ( )

 OK ( )

Vista:

 >  >  > 

 >  > 

XP:

> > ...> 

Win 7:
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3.

 
Desktop partition ( ) 

 

 Desktop Partition ( ) 

�� Find Windows ( ) – 

Find Windows ( ) 

�� Desktop Partition ( ) – Desktop 
Partition ( ) 

 

�� Identify Partition ( ) – 

�� Align On/Align Off ( /
) – /

�� Exit ( ) –  Desktop Partition (
)  Display Tune ( )

 Display Tune (
) 

 

 Desktop Partition ( ) 

 

( )
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3.

�� Find Windows ( ) – 

Find Windows ( ) 

�� Desktop Partition ( ) – 

�� Identify Partition ( ) – 

�� Align On/Align Off ( /
) – /
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4.

4. 
/

LCD
 LED 

22" W (55.9cm)
16:10
0.282 x 0.282 mm
250 cd/m²  

SmartContrast 20,000,000:1 
1000:1
5ms
1680 x 1050 @ 60Hz
170º(H) / 160º(V) @ C/R > 10
1670 
56 Hz - 76 Hz
30 kHz - 83 kHz

sRGB

DVI VGA

/  (220S4LA) PC

 (220S4LA) 1.5Wx2

 (220S4LA)

OSD  

Kensington 
DDC/CI sRGB Windows 7/Vista/XP Mac OSX Linux 

-5 / +20 
 (220S4LC) -65/+65

 (220S4LC) 110mm

220S4LA: 20.4W 30.2W(max)
220S4LS/220S4LC: 20.4W

EnergyStar 5.0  
 

100VAC, 50Hz
 

115VAC, 60Hz
 

230VAC, 50Hz
 15.7W 15.7W 15.7W

0.1W 0.1W 0.1W
0.1W 0.1W 0.1W
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4.

*  
100VAC, 50Hz

 
115VAC, 60Hz

 
230VAC, 50Hz

53.58 BTU/hr 53.58 BTU/hr 53.58 BTU/hr
0.341 BTU/hr 0.341 BTU/hr 0.341 BTU/hr
0.341 BTU/hr 0.341 BTU/hr 0.341 BTU/hr

 LED  /  
100-240VAC 50-60Hz

(WxHxD) 
504 x 434 x 207 mm(220S4LS/220S4LA)
504X400X228 mm(220S4LC)

(WxHxD) 504X394X60 mm

 4.45 kg (220S4LS/220S4LA)
5.2 kg (220S4LC)
3.38 kg
6.35 kg (220S4LS/220S4LA)
7.1 kg (220S4LC)

0°C  40°C
 

 -20°C  60°C

20%  80%
MTBF 30,000  

ROHS 
EPEAT Gold (www.epeat.net)

100% 
100% PVC BFR

EnergyStar

CE Mark FCC Class B SEMKO UL/cUL BSMI GOST  
ISO 9241-307, TCO

/

  
1. EPEAT Gold  Silver  Philips  ,

 www.epeat.net
2.   www.philips.com/support 
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4.

4.1 

 
 1680 x 1050 @ 60 Hz  
 1680 x 1050 @ 60 Hz

 
 1680 x 1050 @ 60 Hz

(kHz) (Hz)
31.47 720x400 70.09 
31.47 640x480 59.94 
35.00 640x480 66.67 
37.86 640x480 72.81 
37.50 640x480 75.00 
37.88 800x600 60.32 
46.88 800x600 75.00 
48.36 1024x768 60.00 
60.02 1024x768 75.03 
44.77 1280x720 59.86 
63.89 1280x1024 60.02 
79.98 1280x1024 75.03 
55.94 1440x900 59.89 
70.64 1440x900 74.98 
64.67 1680x1050 59.88 
65.29 1680x1050 59.95 

  
 1680 X 

1050 @ 60Hz  
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5.

5. 
 PC  VESA DPM 

 
 

 

VESA     LED  

  20.4W

 
 0.1W  

 

- - 0.1W

�  1680 x 1050
�  50%
�  250 
�  6500k 
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6.

6. 
Congratulations!
This display is designed for both you and the 
planet.

The display you have just purchased 
carries the TCO Certi�ed label. 
This ensures that your display is 

designed, manufactured and tested according to 
some of the strictest quality and environmental 
requirements in the world. This makes for a high 
performance product, designed with the user 
in focus that also minimizes the impact on the 
climate and our natural environment.

TCO Certi�ed is a third party veri�ed program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certi�ed represents one of the toughest 
certi�cations for displays worldwide.

Some of the Usability features of the TCO 
Certi�ed for displays:
� Visual ergonomics for good image quality 

is tested to ensure top performance and 
reduce sight and strain problems. Important 
parameters are luminance, contrast, 
resolution, black level, gamma curve, colour 
and luminance uniformity and colour 
rendering.

� Products are tested according to rigorous 
safety standards at impartial laboratories.

� Electric and magnetic fields emissions as 
low as normal household background 
levels.

� Low acoustic noise emissions (when 
applicable).

Some of the Environmental features of the 
TCO Certi�ed for displays: 
� The brand owner demonstrates corporate 

social responsibility and has a certified 
environmental management system (EMAS 
or ISO 14001).

� Very low energy consumption both in on- 
and standby mode minimize climate impact.

� Restrictions on chlorinated and brominated 
flame retardants, plasticizers, plastics and 
heavy metals such as cadmium, mercury 
and lead (RoHS compliance).

� Both product and product packaging is 
prepared for recycling.

� The brand owner offers take-back options.
The requirements can be downloaded from our 
web site. The requirements included in this label 
have been developed by TCO Development in 
co-operation with scientists, experts, users as 
well as manufacturers all over the world. Since 
the end of the 1980s TCO has been involved 
in in�uencing the development of IT equipment 
in a more user-friendly direction. Our labeling 
system started with displays in 1992 and is 
now requested by users and IT-manufacturers 
all over the world. About 50% of all displays 
worldwide are TCO certi�ed.

For more information, please visit:  
www.tcodevelopment.com

 TCOF1058 TCO Document, Ver. 2.1

Technology for you and the planet
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6.

Lead-free Product
Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated and 
compliance with European community s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

EPEAT
(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 51 
environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Bene�ts of EPEAT
Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste 
EPEAT S requirement that all registered 
products meet ENERGY STAR s energy 
ef�ciency speci�cations, means that these 
products will consume less energy throughout 
their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 

� EN60950-1:2006+A11:2009 (Safety 
requirement of Information Technology 
Equipment).

� EN 55022:2006+A1:2007 (Radio 
Disturbance requirement of Information 
Technology Equipment).

� EN55024:1998+A1:2001+A2:2003 
(Immunity requirement of Information 
Technology Equipment).

� EN 61000-3-2:2006+A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

� EN 61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

� 2006/95/EC (Low Voltage Directive).
� 2004/108/EC (EMC Directive).
� 2005/32/EC (EuP Directive, EC No. 

1275/2008 mplementing Directive 
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards 

� ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

� GS EK1-2000:2009 (GS mark requirement).
� prEN50279:1998 (Low Frequency Electric 

and Magnetic fields for Visual Display).
� MPR-II (MPR:1990:8/1990:10 Low 

Frequency Electric and Magnetic fields).
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6.

Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 
guidelines for energy ef�ciency.

 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

� Reorient or relocate the receiving antenna.
� Increase the separation between the 

equipment and receiver.
� Connect the equipment into an outlet on 

a circuit different from that to which the 
receiver is connected.

� Consult the dealer or an experienced 
radio/TV technician for help.

 Changes or modi�cations not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device. 

To prevent damage which may result in �re or 
shock hazard, do not expose this appliance to 
rain or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
limites sont conçues de façon à fourir 
une protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  



30

6.

Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

� Réorienter ou déplacer l antenne de 
réception.

� Augmenter la distance entre 
l équipement et le récepteur.

� Brancher l équipement sur un autre 
circuit que celui utilisé par le récepteur.

� Demander l aide du marchand ou d un 
technicien chevronné en radio/télévision.

 Toutes modi�cations n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certi�cation 
Notice
The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" con�rms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL:  
SØRG VED PLACER INGEN FOR , AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS:  
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

Auf der Rückwand des Gerätes be�ndet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III � 5 Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1. Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.  nur original-Ersatzteile verwendet werden. 
3.  bei Ersatz der Bildröhre nur eine 

bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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6.

China RoHS 
The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products produced and sold for China 
market have to meet China RoHS request.

RoHS

(Pb) (Hg) (Cd) (Cr6+) (PBB) (PBDE)

O O O O O O

X O O O O O

X O O O O O

X O O O O O

X O O O O O

*:  

O:  

X:  

X RoHS

EU Energ Lable

XXXXXX

A

XYZ
XYZ

XYZ XYZ

The European Energy Label informs you on 
��	�	
	��
�	����	
�
������������������������
��	���		
	����	�	
	��
�	����	
�
���������������
product is the lower the energy it consumes. 

�
���	����	���
�����
��
����	�	
	��
�	����	
�
�
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

 Note:
The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7.
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7.

7.2 
www.philips.com/support

 

/ ASC
Germany Siemens I&S +49 01803 386 853 € 0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 € 0.10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 € 0.08
Netherlands E Care +31 0900 0400 063 € 0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens I&S +43 0810 000206 € 0.07
Belgium E Care +32 078 250851 € 0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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7.

Country Call center ASC Consumer care number
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA ServiceNet LV  Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
Serbia & 
Montenegro NA Kim Tec d.o.o. +381 11 20 70 684

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045 
NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832 
Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331 
NA Pro� Service +36 1 814 8080

Country Call center Consumer care number
Brazil

Vermont 
0800-7254101

Argentina 0800 3330 856

 
 4008 800 008

Country Call center ASC Consumer care number
U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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7.

APMEA 

Country Call center ASC Consumer care number
Australia NA AGOS NETWORK PTY LTD 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
Hong Kong / 
Macau NA Smart Pixels Technology Ltd. Hong Kong:Tel: +852 2619 9639 

Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Indonesia NA PT. Gadingsari elektronika 
Prima

Tel: 62 21 75909053, 75909056, 
7511530

South Korea NA PCS One Korea Ltd. 080-600-6600

Malaysia NA After Market Solutions (CE) 
Sdn Bhd 603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer 
Care Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thailand NA Axis Computer System Co., 
Ltd. (662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 
United Arab 
Emirates NA AL SHAHD COMPUTER 

L.L.C 00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc. (02) 633-4533 to 34, 
(02) 637-6559 to 60

Sri Lanka NA no distributor and/or service 
provider currently

Bangladesh NA Distributor: Computer Source 
Ltd (warranty buy-out)

880-2-9141747, 9127592 
880-2-8128848 / 52

Nepal NA Distributor: Syakar Co. Ltd 
(warranty buy-out) 977-1-4222395 

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) (warranty 
buy-out)

855-023-999992
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8.

SmartControl Premium
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8.
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